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[bookmark: _Toc233731761]INTRODUCTION
The Full Campaign Manager gives you the ability to target your client bank by creating your own sales and marketing campaigns.
You can run queries on all of your clients to a broad or specific range using query builder (with over a billion query combinations), then, based on your selected criteria can send your branded campaign via SMS, Email or Letter.
You can also use Campaign Manager to quickly, simply and without additional charge deliver your servicing arrangement/proposition to your clients e.g., Quarterly Newsletters.
Do not forget, the more defined the search and targeted the campaign, the better the response.
You are responsible for obtaining the appropriate sign off processes to meet Financial Promotions requirements and strongly advise producing/trialing the campaign material ‘in house’ before sending to clients.
[bookmark: 2.0_Using_Campaign_Manager][bookmark: _bookmark1][bookmark: _Toc233731762]USING CAMPAIGN MANAGER
To access Campaign Manager, go to; Office > Tools > Campaign Manager.
You have the option to build your own query or select from ‘Saved Queries’ for ones that you have previously created and saved which can be re-used. This will enable you to build simple queries for broad messages or specific campaigns based on a more targeted client group based on specific, more complex criteria.
[image: ]
[bookmark: 3.0_Hints_&_Tips][bookmark: _bookmark2]
[bookmark: _Toc233731763]HINTS & TIPS	
Query Builder will automatically add the filter to disregard clients that have opted out of marketing communications. This is taken from the case status on the 360 case record.
You can amend these manually if required and this can be done within ‘Maintenance’ > ’Clients’ > ’Case Status’. By clicking on a case status, you will then have an option to tick ‘Marketing Allowed’. Change the case status accordingly on the case record within the screen showing the clients personal details.
[image: ]
[bookmark: 4.0_Using_the_Query_Builder][bookmark: _bookmark3][bookmark: _Toc233731764]USING THE QUERY BUILDER	
To begin building your campaign, first you will need to decide who your target audience is.
To the right of the screen, you will see several options to help you build your specific query.
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The first is Result Type, which can be either ‘Case’ or ‘Client’.
This will determine whether your campaign material is client specific or to be communicated to all individuals held within a case record that meets the criteria.
If you select Result Type = Case and ran a query on Date of Birth equals 1/1/1980, this would include and market to all clients on a case record, providing one individual on the case held the date of birth as 1/1/1980.
If you select Result Type = Client and ran a query on Date of Birth equals 1/1/1980, this would only return and include clients with a date of birth as 1/1/1980, disregarding all others included on the case record.
It is recommended that most campaigns will be ran with Result Type as Client, particularly targeted campaigns.
Select Table = This is the ‘Table’ or section of the database you would like to query
i.e. Mortgage policies, Life policies, Client specific details or Case specific details.
Select Field = The Field pick list items you choose from can vary, depending on the Table selected.
Add Clause = This is an AND statement e.g. “Has a mortgage with Halifax AND the mortgage end date is between XX/XX/XXXX and XX/XX/XXXX”
Add Group = This is an OR statement e.g. “Has a mortgage with Halifax OR Nationwide”
Add Exclusion Group = THEY DON’T HAVE e.g. “Find all clients that DON’T’ have an ISA”
Each layer you want to add onto your query you need to amend the Select Table and Select Field and click on ADD Clause, Group or Exclusion.
[bookmark: 5.0_Building_a_Campaign][bookmark: _bookmark4][bookmark: _Toc233731765] BUILDING A CAMPAIGN
Below are two example scenarios to show how the logic is applied and enable you to build your own queries. Please note that you can Run Query at any point within the campaign building process to see the number of results returned and how this changes as more criteria is added.
[bookmark: _Toc233731766]Example #1 – a list of clients with a birthday of 30th December
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At Result Type select Client
On the ‘Table’ dropdown, select ‘Client’, as this is client specific information.
For the ‘Field’ dropdown, select either ‘DOB – Month of Birth’ and/or ‘DOB – Day of Birth’ (this can be done in any order).
Click ‘Add Clause’ which will then add a line in which follows the below format
TABLE NAME – FIELD NAME – Equals – XXX
Update the clause to fit the criteria (in this example, Day of Birthday EQUALS
30
Do the same for the Month clause also by selecting the relevant month
Select ‘Run Query’ at the bottom of the screen to view your results
[image: ]If you wish to save this query, type in a name against Query Name and click Save Query to enable you to run that query again in the future from the ‘Saved Queries’ drop down selection.
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[bookmark: _Toc233731767]Example #2 – List all clients that have a mortgage with Halifax and the product end date is Quarter 1 (Q1) 2021
1. At Result Type select Client
2. On the ‘Table’ dropdown, select ‘Mortgage’, as we require Mortgage specific information.
3. For the ‘Field’ dropdown, select either ‘Lender’ or ‘End Date’ (this can be done in any order).
4. Click ‘Add Clause’ which will then add a line in which follows the below format
a. TABLE NAME – FIELD NAME – Equals/Greater Than or Equal/Less Than or Equal – XXX
5. Update the clause to fit the criteria (in this example, Lender EQUALS Halifax
6. Do the same for the End Date clause also by inputting the date(s)
7. Select ‘Run Query’ at the bottom of the screen to view your results
If you wish to save this query, type in a name against Query Name and click Save Query to enable you to run that query again in the future from the ‘Saved Queries’ drop down selection.
[bookmark: 5.1_‘Saved_Queries’][bookmark: _bookmark5][bookmark: _Toc233731768][image: ]‘Saved Queries’











‘Saved Queries’ are queries you have previously created and saved for future use. You can also delete these from the dropdown list as shown above.
[bookmark: 5.2_Removing_Clients_from_the_Result_Lis][bookmark: _bookmark6][bookmark: _Toc233731769]Removing Clients from the Result List
Once you have your results you may wish to remove certain clients from your client list. Simply click on click in the checkbox of any clients you wish to remove and select ‘Remove Items’.
[image: ]
[bookmark: 6.0_Exporting_Your_Client_List][bookmark: _bookmark7][bookmark: _Toc233731770]EXPORTING YOUR CLIENT LIST	
[bookmark: 6.1_Export_Results][bookmark: _bookmark8]With your final list of clients displayed, you can also export the list to Excel so you can mailshot outside of Campaign Manager or Export Results of which can then be reimported back into Campaign Manager at another point in the future.
[bookmark: _Toc233731771][image: ]Export Results

This is as sounds and will allow you to export the results of your specified search, however it does so in a format which can be easily imported back into the system. This is useful if you wish to do a follow up campaign to the same clients at some point.
All you need to do once you have your list ready is select ‘Export Results’ this will bring up the ‘Save as’ screen within your P.C.
[image: ]Type a filename you will easily remember and select save, this file type is designed as a back-up and may not be readable to you. However, if you later wish to re-import these clients, this can be done quickly and easily by selecting the ‘Import Results’ button, this will allow you to search and re-select the file from within your computer.


[bookmark: 6.2_Export_to_Excel][bookmark: _bookmark9][bookmark: _Toc233731772]Export to Excel
If you wish to save your list of clients in a format which can be viewed outside of Campaign Manager, you can save this as an Excel CSV document, just by selecting the next button along which is ‘Export to Excel.’
[image: ]

This can be done in the same way as before, once you have selected ‘Export to Excel’ as above, you will be given the option to save as your chosen file name within your documents or to your desktop.
[bookmark: 7.0_Sending_Campaigns][bookmark: _bookmark10][bookmark: _Toc233731773] SENDING CAMPAIGNS
With your query build complete, choosing Create Campaign gives you several options to communicate to the client by, either SMS, Printed Letter, Email or Client Portal Message. Either option creates an audit trail against each client/case record included within the campaign, regardless of whether a sales opportunity is created as part of the process. If a sales opportunity has been created, the SMS will show in the notes section of the sales opportunity and the Letter & Email will show in the ‘Sales Opportunity Document’ section. Otherwise, if an opportunity has NOT been created an audit trail will show within ‘Contact History’ for SMS and the ‘Documents’ tab for Emails & Letters.
To Start, select the ‘Create Campaign’ button above the Query Builder screen.
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You will then be offered four choices:
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[bookmark: 7.1_Sending_SMS_Campaigns][bookmark: _bookmark11][bookmark: _Toc233731774]Sending SMS Campaigns
Text messages are a great way of staying in touch with your clients and adding that personal touch. With the SMS Campaign you can stay in touch through a simple Happy Birthday, congratulations on a new purchase or even a gentle reminder that a policy is coming to an end.
There is a maximum of 160 characters to use. Note, as part of your subscription you receive 1000 texts free every month, anything over this will be charged at 4p + VAT per text. Please note that as part of the SMS Campaign process any duplicate mobile numbers will be detected so only one SMS will be sent to each mobile number included within the campaign.
‘SMS Campaign’ is the third option on your ‘Campaign Manager’. Once you have selected ‘SMS Campaign’ you will be able to choose your template type from the drop-down box.
[image: ]After selecting your template, you can change the SMS ID/mobile number that the SMS campaign is displayed from and if there is a salutation merge field the format of the salutation. If you want to send the campaign and allow a client to reply directly back to you, enter a valid mobile number to the ‘SMS ID or Mobile Number’ field. If you want to leave this field as text, please note that there is a limit of 11 characters (inc. spaces).

On choosing ‘Next’ you have the ability to Review your template, confirming the SMS ID/mobile this will be sent from and the content of the message to be displayed on the clients device.


[image: ]
After reviewing the SMS template, you then have the option to ‘Create Opportunity’. If selected this will create a sales opportunity in the servicing advisor’s Hotbox for each of their clients included within the campaign. Creating a sales opportunity as part of the campaign process is a great way of using as a follow up reminder and seeing how successful the campaign has been.
*Please note that in order for you to ‘Create Sales Opportunity’ during your campaign, this functionality will need to be enabled with 360 Lifecycle Office>Maintenance>General>Common Settings>System Settings>Click on ‘Case Defaults’ Tab and finally, selecting the required option from the ‘Opportunity Defaults’ dropdown list*
[image: ]

Before sending the SMS Campaign you are taken to a Final Check screen. This will confirm the number of the clients the campaign will be sent to, if a sales opportunity is to be created against the clients included and that a copy of the campaign material will be stored against the client record. Please note that if a sales opportunity is being created as part of the campaign process then a copy of the campaign will be stored against the opportunity, if not then a copy of the campaign material will be recorded at the Case ID level.
[image: ]Choosing ‘Send Now’ will immediately distribute the campaign. You will receive an automatic email once the campaign has been sent confirming the number of recipients and any duplicate SMS numbers detected.

[bookmark: 7.2_Sending_an_Email_Campaign][bookmark: _bookmark12][bookmark: _Toc233731775]Sending an Email Campaign
An email campaign is a great and cost-effective way of contacting your clients. Please note that any duplicate email addresses within the campaign will be detected so only one email will be sent to each email address included within the campaign.
You can set up new email templates including margins, your company fonts, colours, bold, italic & hyperlinks etc... To set up email templates quickly and easily, in Office, go to ‘Maintenance’ select ‘Email Templates’ and choose ‘New’. You can now create your email template by ‘right clicking’ and adding the required fields by selecting ‘Insert Merge Field’ to pre-populate data. As you create your template email, Spell Check will automatically highlight any mistakes enabling you to ‘right click’ and correct the spelling accordingly. Using Editor, you can also change the fonts and colour of your text. You can reuse the campaigns, the lists or the templates. As per SMS & Letter, a copy of the email campaign will be saved against your client record. When sending an Email campaign, ensure that you add the email disclaimer merge field to the bottom of email template. The email disclaimer merge field is collecting the information held in Office, ‘Tools’ and ‘User Settings’. Email Campaign is the top option on your ‘Campaign Manager’. Once you have selected ‘Email Marketing Campaign’ you will be able to choose your template type [image: ]from the drop-down box.

After selecting your template, you can change the email address that the email campaign is shown from, enter an email subject, add attachments up to a size of 5mb and if there is a salutation merge field within the email template confirm the format of the salutation.
On choosing ‘Next’ you can review your template, confirming the content of the email message to be received by your clients. You can choose ‘Next Record’ to check the content of the next client included within the campaign if you wish.
[image: ]

After reviewing the email template, you then have the option to ‘Create Opportunity’. If selected this will create a sales opportunity in the servicing advisor’s Hotbox for each of their clients included within the campaign. Creating a sales opportunity as part of the campaign process is a great way of using as a follow up reminder and seeing how successful the campaign has been.
*Please note that in order for you to ‘Create Sales Opportunity’ during your campaign, this functionality will need to be enabled with 360 Lifecycle Office>Maintenance>General>Common Settings>System Settings>Click on ‘Case Defaults’ Tab and finally, selecting the required option from the ‘Opportunity Defaults’ dropdown list*
Before sending the Email Campaign you are taken to a Final Check screen. This will confirm the number of the clients the campaign will be sent to, if a sales opportunity is to be created against the clients included and that a copy of the campaign material will be stored against the client record. Please note that if a sales opportunity is being created as part of the campaign process then a copy of the campaign will be stored against the opportunity, if not then a copy of the campaign material will be recorded at the Case ID level.
Choosing ‘Send Now’ will immediately distribute the campaign. You will receive an automatic email once the campaign has been sent confirming the number of recipients and any duplicate email addresses detected.
[bookmark: 7.3_Sending_a_Mail_Merge_Campaign_(Print][bookmark: _bookmark13][bookmark: _Toc233731776]Sending a Mail Merge Campaign (Printed Letter)
A print campaign is produced much in the same way as an email campaign. You can set up new letter templates including margins, your company fonts, logos, colours, bold, italic & hyperlinks etc...
To use and set up letter templates in Office go to ‘Maintenance’ and select ‘Mail Merge Templates’ and choose ‘New’. You can now create your letter template using the Editor to add and include Headers & Footers, change fonts and colours and adjust margins to accommodate your headed paper. By right clicking on your template letter and selecting ‘Insert Merge Field’ you can choose which fields are required to pre-populate data. Add your company logo by clicking the ‘Insert’ tab and then ‘Pictures’. Also included is the ability to add tables to your documents making it possible to produce simple forms. As you create your template letter Spell Check will automatically highlight any errors enabling you to ‘right click’ and correct the spelling accordingly. You can reuse the campaigns, the lists or the templates. The letter will be saved as a document against your client record.
A Printed Letter Campaign is the second option when creating a Campaign. Once you have selected ‘Print Mail Merge’ you will be able to choose your template type from the drop-down box.
After selecting your template, you can confirm the format of the salutation and then preview the template on the next page.
Once you are happy with your template, the same process will be followed with the other campaigns outlined above, allowing the creation of a Sales Opportunity and a Final Check screen before producing your letters. These will be added as documents onto the relevant clients record within the system.
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Select Campaign
Please select the campaign type you require. You will then be given a choice of templates to choose from.

@ Email Marketing Campaign
O Print Mail Merge
O sMs Campaign

O MyFinancecentre Campaign

~ Select a Template-





image15.jpeg
Campaign Manager - Create Campaign

SMS Message Details

Please complete the ID field you wish to appear in the SMS Message, alternatively you can enter 2 mobile number to receive replies. You can edit the SMS

template prior to sending and also select the components of the fullname you wish to appear in the salutation field.

SMS 1D or Mobile Number

AV

Happy Birthday! Have a lovely day.

Include Surname
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Review Template
Please take this opportunity to check the template before you send it out !
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Create Sales Opportunity

Check the box below if you wish to create 2 sales opportunity. This makes it easier to contact your clients 3gain and keep track of campaign progress.

 Create Opportunity

Lead Sources

Lead Types

Campaigns

Create new
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Final Check
Please double check the campaign summary before dlicking the 'Send Now button |

® You have created an SMS Campaign to contact One client on One case.

@ You have chosen not to create a sales opportunies for tracking this campaign. A copy of the text message will be left in
the contact history.

® Please double-check everything. Once you dlick ‘Send Now' the campaign cannot be cancelled.
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Email Message Details
Please complete the email address you wish to appear in the display name of the from address and also the email subject field. Please select which components
of the full name you wish to appear in the salutation field.

From [Gavduressel@3sotfecyde.cok ]

Email Subject [ Mortgage Encing ]

Total Attachment Size: 08

clude T[] Include Forename

Example Salutation: Mr Smith
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Review Template
Please take this opportunity to check the template before you send it out !

Dear Mr Demo

Did you know that your mortgage is coming o its End Date. Please contact us asap so we can
discuss.

David Wressell
david wressell@360lifecycle.co.uk
07737310835
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